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Overview

This chapter explains how to

� invoke the SAS System and SAS/ASSIST software

� access and move around SAS/ASSIST software using menus, function keys, the
index, Help, and buttons

� delete and re-create sample tables

� perform frequently used SAS/ASSIST operations

� exit SAS/ASSIST software and the SAS System.

Note: The illustrations and examples used in this book were created with Version 7
of SAS/ASSIST software under the UNIX operating environment. Your screens may
look somewhat different from the illustrations in this book. 4
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Invoking the SAS System
To invoke the SAS System, follow these steps:

1 Log on to your operating environment.
2 Type the command to access the SAS System (for example, SAS) and press

ENTER. Contact the SAS Support Consultant at your site for the specific
command used at your site to access the SAS System.

Depending on your operating environment and the SAS System configuration at
your site, some or all of the following windows appear:

� Output Window
� Log Window
� Program Editor Window
� SAS Explorer Window

� Results Window
� ToolBox (or tool bar)

Display 2.1 SAS Windowing Environment

Note that some windows may be “hidden” beneath others. To see the other windows,
use one of the following methods, depending on your operating environment:

� Use the View menu to select other windows by name.
� Use the PREVWIND and NEXT function keys to bring windows into view.

� Use your mouse to click on the desired window.

To get more information about any of these windows, select Help from the window’s
menu bar, and then select Using This Window.

Selecting Items
When instructions in this book direct you to “select” an item, use any of the methods

listed below according to your operating environment:
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� If you have a mouse, point to the item and click on it.

� Press TAB or BACKTAB to move the cursor to the item, and then press ENTER.

� Use the arrow keys to position the cursor on the item, and then press ENTER.

Entering Commands
You can enter commands within the SAS System by using one of three methods:

� selecting from menus

� using function keys

� typing the commands at the Command ===> prompt or in the ToolBox command
window.

Menus and function keys are described in the following sections. Typing commands at
the Command ===> prompt or in the ToolBox command window is not discussed in this
book. Contact the SAS Support Consultant at your site for further information about
using commands with the SAS System.

Note: This book uses menus for all examples. 4

Using Menus
A menu is a list of functions, actions, or commands. Pull-down menus appear below

items that you select in the menu bar at the top of a screen. Pop-up menus can appear
anywhere in a screen. In SAS/ASSIST software, you activate pop-up menus by selecting
the buttons in the WorkPlace menu. Each menu has items that you can select to
perform certain actions.

Note: Some actions are also available through the function keys. You can use either
the menus or the function keys to perform these actions, whichever you prefer.
Performing an action using function keys often requires fewer keystrokes than
performing the same action using menus. See “Using Function Keys” on page 15 for
further information about function keys. 4

1 To use menus, do one of the following:

� If you have a menu bar at the top of your SAS windows, continue to the next
step.

� If you have a Command ===> prompt at the top of your SAS windows, you
need to invoke the menu bar to follow the examples in this book. To invoke
the menu bar, type pmenus on at the Command ===> prompt and press
ENTER. The menu bar replaces the command line.

� You can also use a function key defined as COMMAND or PMENU to switch back
and forth between a command line and menus.

Note: For Microsoft Windows and OS/2 users, your menu bar is at the top of the
main SAS System window. It changes according to which SAS window (Program
Editor, Log, Output, and so on) is active. Click on the Program Editor window to
activate it. 4

2 To use an item on the menu bar, select it. For example, select File from the
Program Editor menu bar. The File menu appears.
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Display 2.2 File Menu

3 Select the action you want to perform. If an action has dots next to it, when you
select the action, another window appears. For example, select Save As... from
the File menu. The Save As window appears.

Display 2.3 Save As Window

4 To exit a window, select the appropriate button, for example, Cancel, OK, Close, or
Goback. For this example, select Cancel.

5 If an action has a triangle or an arrow next to it, when you select the action,
another menu appears. This feature is called cascading menus. For example,
select Solutions and then Analysis. A menu of various SAS System-related
options appears.
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Display 2.4 Cascading Menus

6 To exit a menu, use a mouse to point to a location outside the menu box, and then
click the mouse button; or, use the arrow keys to position the cursor anywhere
outside the menu box, and press ENTER. Make sure the cursor is not on another
item on the menu bar or on an item on the window, or else that item will be
selected when you click the mouse button or press ENTER.

If you want to return to a command line from the menu bar, follow this selection
path:

Tools I Options I Turn Command Line On

The menu bar is replaced by a Command ===> prompt.

Using Function Keys
Function keys are keyboard keys that you can define to perform different actions.

When you are using SAS/ASSIST software, the function keys help you to perform
certain actions quickly.

Note: Some actions are also available through the menus. You can use either the
menus or the function keys to perform these actions, whichever you prefer. Performing
an action with function keys often requires fewer keystrokes than does performing the
same action with menus. While the examples in this book use menus, you can use
function keys instead. 4

1 To see how each key is defined when you first access the SAS System, follow this
selection path from any SAS window:

Tools I Options I Keys

A list of function keys and their corresponding actions appears.
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Display 2.5 KEYS Window

Note: The default function key assignments vary among different operating
environments. Your KEYS window may look different from the one pictured here. 4

2 If some function keys are not visible in the window, use the scroll bars or the
FORWARD and BACKWARD function keys to view all the key settings. Note which
keys correspond to certain actions. Actions that you need to perform often include

� END, which closes the window. Using a key defined as the END command
can be faster than selecting Close from a menu.

� FORWARD, which shows the next screen of data in the current window.
� BACKWARD, which shows the previous screen of data in the current window.
� RIGHT, which shows the data to the right of the current window.
� LEFT, which shows the data to the left of the current window.
� PREVWIND, which shows the previously viewed SAS window.
� NEXT, which shows the next SAS window. You can use PREVWIND and

NEXT to view the various SAS windows.
� PMENU (or COMMAND), which toggles between the menu bar and the

command line. If the menu bar is being used, this function key invokes the
command line. If the command line is being used, this function key invokes
the menu bar. Note that if SAS/ASSIST software is active, the PMENU
command is not valid. COMMAND is always valid.

Note: Depending on your operating environment, some of the keys listed above
may not already be defined in the KEYS window. 4

3 To assign a command to a function key, place the cursor in the Definition
column for the desired function key and type the command. For a description of
SAS System commands, see the online SAS System Help. Some additional
commands that you can use in SAS/ASSIST software include

� RUN, which executes the task in the current task window.
� NEW, which clears task window selections except for the active table and any

Subset Data selections.
� GOBACK, which does the same thing as selecting the Goback button.
� RESULTMAN, which invokes the Result Manager.
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� MMENU, which returns you to the WorkPlace menu.
4 To exit the KEYS window, use one of the following methods:

� Follow this selection path:

File I Close

� Use the END function key.

If you have made changes, a dialog box opens, asking you if you want to save the
changes. Select Yes to save the changes or No to exit without saving. The KEYS
window disappears.

Note: You can also access the KEYS window from SAS/ASSIST software using the
same method described earlier in this section. 4

Invoking SAS/ASSIST Software
To invoke SAS/ASSIST software, follow these steps:

1 From any SAS System window, follow this selection path:

Solutions I ASSIST

If this is the first time that you have run SAS/ASSIST software, a Welcome
window appears; proceed to step 3.

Display 2.6 SAS/ASSIST Welcome Window

If this is not the first time that you have run SAS/ASSIST software, the
SAS/ASSIST Start Menu appears.
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Display 2.7 SAS/ASSIST Start Menu

2 The Start Menu gives you several options:

� You may choose to use the new WorkPlace environment, or you can use the
menu system (Block Menu) from Version 6 of SAS/ASSIST software.

� You may choose to go directly to the last task that you performed using
SAS/ASSIST software, or you may choose to go directly to the Result
Manager to perform one of your saved tasks. See Chapter 6, “Using the
Result Manager,” on page 69 for details about using the Result Manager.

� You may choose to suppress the Start Menu the next time you invoke
SAS/ASSIST software.

For now, leave these options as they are and proceed to the next step.

3 Select Continue. The SAS/ASSIST WorkPlace menu appears.

Display 2.8 SAS/ASSIST Workplace Menu
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Using Buttons
A button is a graphical shape in a window that, when selected, results in an action.

OK, Cancel, and Run are examples of buttons. The most commonly used buttons are
described here:

OK accepts what you have entered in the window and takes you to
additional windows to continue the task. In some cases, OK performs
the task.

Cancel cancels what you have entered in the window and returns to the
previous window.

Goback returns to the previous window.

Help displays help for the feature in use.

Finding Items
If you cannot find the item that you want to use in SAS/ASSIST software, you have

two guides to help you:
� Use the Tasks menu and its cascading menus to explore the different capabilities

of SAS/ASSIST software.
� Select the Index button from the WorkPlace menu to display an alphabetic list of

all the tasks and functions that can be performed with SAS/ASSIST software. To
access one of the tasks, select it from the Index list. The software takes you
directly to the task. When you exit the task, the software returns you to the Index.

Getting Help
The SAS System has extensive online help. You can get help for a particular window

or general SAS software product help. To access the general SAS System help, follow
this selection path:

Help I SAS System Help

Help topics are formatted in Hypertext Markup Language (HTML) and appear in a SAS
Help Browser or in an HTML browser (for example, Microsoft Internet Explorer or
Netscape Navigator). Various items in the Help browser window are highlighted,
underlined, or otherwise emphasized. You can select these items to get more
information about them. To access general SAS/ASSIST software help, follow this
selection path from the main SAS System help screen:

Help on SAS System Products I SAS/ASSIST I Using SAS/ASSIST

To get help for a particular window, follow this selection path from that window’s
menu bar:

Help I Using This Window

Help for that window appears.

Using HTML Output
SAS/ASSIST software can generate HTML-formatted output for reports and

graphics. You can then view your output in an HTML browser, as in the following
example.
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Contact the SAS Support Consultant at your site for more information about HTML
browsers available to you.

To generate HTML output with SAS/ASSIST software, see “Setting Up HTML
Output” on page 177. This may have already been done for you; see the SAS Support
Consultant at your site for more information.

Using SAS/ASSIST Software with This Book
In creating the examples and illustrations in this book, we removed the date and

time stamp from all output and disabled the Save Changes dialog box that appears
when you exit a task window. We recommend you do the same so that your experience
with SAS/ASSIST software will match the descriptions in this book. This section
describes how to apply these conditions.

Removing the Date and Time Stamp from Your Output
To remove the date and time from your output, follow this selection path from the

SAS/ASSIST WorkPlace menu bar or any task window menu bar:

Edit I Page Headers I Print current date

Note: This option is not applicable to graphics output and is not available on
graphics task windows. 4

Disabling the Save Changes Dialog Box
To disable the Save Changes dialog box, the SAS/ASSIST user profile option

Confirm changes is set to No. To set this option, do the following:

1 Follow this selection path from the WorkPlace menu bar or any task window menu
bar:

Tasks I Setup I Profiles I User...

The User Profile window appears.

2 In the Value field for the Confirm changes option, type no and press ENTER.

3 Follow this selection path to return to the WorkPlace menu:
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File I Close

If you do not set this option to No, you will be presented with a Save Changes dialog box
every time you exit a task window.

Creating the Sample Tables
In order to perform the exercises in this book, you must create the sample tables.

These sample tables are used throughout this book and can be used to learn to use the
software. When you are using these sample tables, you can try any of the options in
SAS/ASSIST software. You do not need to be concerned about harming the sample data.
You can easily re-create the sample tables if, for example, you have altered them so that
they no longer correspond to the SAS/ASSIST software documentation and tutorial
examples.

1 To create or re-create the sample tables, follow this selection path from the
WorkPlace menu:

Tasks I Setup I File Management I Sample tables...

The Sample Tables window appears.

Display 2.9 Sample Tables Window

2 Select Create sample tables... from the Sample Tables window. The Create
Sample Tables window appears.
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Display 2.10 Create Sample Tables Window

3 Select the tables you want to create. For the exercises in this book, select all the
tables.

Note: If you are re-creating sample tables (rather than creating them for the first
time), and you attempt to re-create a table that is the currently active table in one
or more SAS/ASSIST tasks, you get an error message because SAS/ASSIST
software does not let you re-create an active table. To remove a table from active
status, follow the directions in “De-Selecting an Active Table” on page 25. 4

4 Select OK. The sample tables are created. Depending on your hardware and
operating environment, this may take several minutes. When the process is
complete, a message appears that indicates that all the tables were created.

Display 2.11 Create Sample Tables Message

5 Select Goback twice to return to the WorkPlace menu.

Deleting the Sample Tables
If you no longer wish to use the sample tables, you can delete them.
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1 To delete the sample tables, follow this selection path from the WorkPlace menu:

Tasks I Setup I File Management I Sample tables...

The Sample Tables window appears as in Display 2.9 on page 21.

2 Select Delete sample tables... from the Sample Tables window. The Delete
Sample Tables window appears.

Display 2.12 Delete Sample Tables Window

3 Select the tables that you want to delete.

Note: You cannot delete a table that is currently the active table in one or more
SAS/ASSIST tasks. To remove a table from active status, follow the directions in
“De-Selecting an Active Table” on page 25. 4

4 Select OK. A message appears that indicates that the selected tables were deleted.

Display 2.13 Deleted Sample Tables Message

5 Select Goback twice to return to the WorkPlace menu.
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Frequently Used SAS/ASSIST Operations
This section describes how to perform operations that are common to most

SAS/ASSIST tasks. The task examples in this book refer you to this section when these
operations are required.

Selecting a Table
When a task example instructs you to select a table, follow these steps:

1 If you have not already done so, select the Table button in the task window. The
Select table window appears.

Display 2.14 Select Table Window

The Select table window contains a list of SAS data libraries on the left side and a
list of SAS tables on the right. If there is an active table, the table name appears
in the Selected table field as a two-level name. See “SAS Files” on page 113 for
details about SAS naming conventions.

2 Use one of the following methods to select a table:
� Type the two-level table name in the Selected table field.
� Select the SAS data library name from the Libraries list, and then select

the table name from the Tables list. The sample tables used in the examples
in this book are all located in the SASUSER library.

If the desired table does not appear in the list of tables, it either does not
exist, is not in a library that the SAS System knows about, or was added to a
library after SAS/ASSIST software was invoked.

� For sample tables, see “Creating the Sample Tables” on page 21.
� For tables in undeclared libraries, see “Using SAS/ASSIST Software to

Assign a New Libref” on page 117 for details about declaring libraries.
� For newly added tables, follow this selection path to cause SAS/ASSIST

software to re-examine all libraries for tables:

Tools I Update data
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3 Select OK. The Select table window disappears.

Selecting a Column
When a task example instructs you to select a column, follow these steps:

1 If you have not already done so, select the appropriate button (for example,
Columns, Chart column, or Analysis column) in the task window. The Select
Table Variables window appears with the available columns in the Available list.
(Note that “variable” is another word for “column.”)

Display 2.15 Select Table Variables Window

The number of columns you can select is indicated above the Available list. In
certain contexts, not all of the active table’s columns are listed. For instance, when
the software performs an action that requires numerical data, only numerical
columns are listed.

2 Select the desired column name from the Available list.
3 Select the right–arrow button. The column name disappears from the Available

list and appears in the Selected list.

Note: In certain tasks, you can select more than one column at a time; in others,
you can select only one column. If you can select only one column, the Select Table
Variables window disappears when you select the right-arrow button, and the
column name appears in the task window. In this case, you do not need to go any
further in this procedure. 4

To de-select a column, select it in the Selected list and select the left–arrow
button to move it back to the Available list.

4 Repeat Steps 2 and 3 for each desired column.

Note: If you want to select all of the available columns, you can select the
double–right–arrow button to select them all at once instead of selecting them one
at a time. 4

5 Select OK. The Select Table Variables window disappears.

De-Selecting an Active Table
You can clear task window selections by selecting New from the File menu.

However, this action does not clear the Active Table selection or the Subset Data
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selection. The reason for this feature is that many users wish to use the same subset of
the same data for multiple tasks. To clear the Active Table and Subset Data selections,
follow the steps in this section. To clear only the Subset Data selection, see the
instructions in the next section.

1 Use the Tasks menu to go to the desired task window.

2 Select Table. The Select table window appears.

3 Select Reset, and then select OK. The task window reappears with the Active
Table field cleared.

Note: These steps also clear the other window selections. 4

Clearing a Subset Data Selection
You can clear task window selections by selecting New from the File menu.

However, this action does not clear the Active Table selection or the Subset Data
selection. To clear only the Subset Data selection, follow the steps in this section. The
reason for this feature is that many users wish to use the same subset of the same data
for multiple tasks. To clear both the Subset Data selection and Active Table, see the
instructions in the previous section.

1 Use the Tasks menu to go to the desired task window.

2 Select Subset data. The Subset Data window appears.

3 Select the subsetting method you want to clear (BY columns, WHERE clause, or
Restrict rows). The selection window for that method appears.

4 Select Reset. The default value for that method is restored.

5 Select OK. The Subset Data window reappears.

6 Repeat steps 3 through 5 for each desired subsetting method.

7 Select Goback. The Subset Data window disappears.

Exiting a Task
When you are finished with a task, you can either return to the WorkPlace menu or

go on to another task:

� To return to the WorkPlace menu, follow this selection path:

File I Close

� To go on to another task, select Tasks, and then select the desired task.

Exiting SAS/ASSIST Software
To exit SAS/ASSIST software, return to the WorkPlace menu and select Exit. The

SAS/ASSIST window disappears.

Exiting the SAS System
To exit the SAS System, use one of the following methods:

� From the SAS Explorer window, Program Editor window, Results window, or SAS
Environment window, select File from the menu bar, and then select Exit. A
prompt confirms that you want to exit.
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Display 2.16 SAS Exit Prompt When Using the Menu Bar

Select OK to exit the SAS System.
� In the SAS ToolBox command window, or at a Command ===> prompt, type BYE

and press ENTER. The SAS System terminates without further prompting.

The remaining chapters in this book provide you with step-by-step instructions for
completing the most commonly used tasks of the SAS System by using SAS/ASSIST
software.
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